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* Excel is a spreadsheet program in the
Microsoft Office system. You can use Excel
to create and format workbooks (a
collection of spreadsheets) in order to
analyze data and make more informed
business decisions. You can use Excel to
track data, build models for analyzing data,
write formulas to perform calculations on
that data, pivot the data in numerous ways
(using PivotTable or PowerPivot), and
present data in a variety of professional
looking charts. In this ShortCourse, you will
become familiar with the BASIC
fundamentals of Excel.

Introduction




e Recognize the parts of the Excel workspace;
e Create and save a workbook;

CO urse e Work with editing tools;
O bJ ect|ves e Resize, insert, and remove columns and

rOwWSs;
e Enter Data & work with formulas
e Use Auto Fill features to fill data series;

e |[nsert, delete, move, and rename
worksheets;

e Preview and print a workbook




Creating a Document



Creating a New Workbook

1. On the File tab, New, click the Blank Workbook.

2. Click on more templates, to base a new Workbook on a template.

3. Search for a template.

Good morning

-

{ Lowa Amortistion chedula |
1 @
Blank workbook Personal monthly budget Loan amortization schedule Weekly chore schedule Any year custom calendar
@ I
More t I = ~
&
= New
(n) Home A -
1
[ e ]
B open .
5
Infa o
Blank workbook
Saw
Save As
Search for online template 0
Suggested searches: Business Personal i

Weekly chore schedule




Saving a Workbook

1. From the File tab, click Save As.
2. Select a place to save your file.
3. In the File name box, enter a name for your workbook.

4. Click Save to finish.

5. Click the left arrow to go back to your file. =
Save As
ﬂﬁ Home
’@ Recent
B New
B> Open Texas Tech University

. OneDrive - Texas Tech University

Maggie.Corrigan@ttu.edu
Info

Save Sites - Texas Tech University

Maggie.Corrigan@ttu.edu
Other locations

pPrint E@ This PC
Share

@ Add a Place
Export

B Browse
Publish

Close

Pinned

Pin folders you want to easily find later. Click the pin icon that appears wher

Yesterday

Education
Corrigan, Maggie's OneDrive - Texas Tech University » Document:

Older

E Androgogy vs. Pegagogy

Corrigan, Maggie's OneDrive - Texas Tech University » Document:

E Desktop

Corrigan, Maggie's OneDrive - Texas Tech University » Document:



Definitions

* Columns are vertical group of cells denoted with an alphabetical header at the top, running left to right (A, B, etc.).
* Rows are horizontal group of cells denoted with numerical headers, running from top to bottom (1, 2, etc.).
* Cells are intersections of rows & columns.

* Cell address (aka Cell Reference) identifies the location of the cell in the spreadsheet. A cell address is a
combination of column letter and row number of a cell, such as C4 or D8. Note: When identifying a cell by its
address, the column letter is always listed first followed by the row number.

e Cell Range is a group of cells, such as D2:D4
* Formula bar is the area of the window where text and formulas can be edited and entered.
 Worksheet is a spreadsheet for text, numbers, formulas — it is the basic work area in Excel.

 Workbook is the entire Excel file. Think of the workbook as a three-ring binder. Each workbook automatically opens
with three worksheets, but more can be added if needed.

e Active Cell is a cell with a bold outline around the cell.



Cell Basics




Cell Content

* Cells can contain text, such as letters, numbers, and dates.

Sales

93
42
46
73
12
24
19

C
Percentage of Total
0.71
0.78
0.86
0.28
0.49
0.65
0.57



Data Entry

To manually enter data:

1.Select an empty cell, such as A1, and
then type text or a number.

2.Press Enter or Tab to move to the next
cell.

A B C D
1 |Department Ql Qa2 l
2 |Sales
3 |HR ml
4 L]
5 .
Jan  |Feb lMar Apr May Jun .I
2014 '
2015

2016
2017
2018



Auto Fill ( Filling in data from a series

1. Enter the beginning of the series in two cells: such as Jan and Feb; or 2014 and 2015.

2. Select the two cells containing the series, and then drag the fill handle across or down the cells.

t AutoSave (.Off) Book1 - Excel R Search (Alt+Q) & AutoSave (. Off)‘ Book1 - Excel
File  Home Insert Pagelayout Formulas Data Review View Help File Home Insert Pagelayout Formulas Data Review View
~ . A v - — Ger v ~ o av = —
? fﬁ] [‘%g’ Calibri 11w AT A = = E] L b ; ¥ Ifi] & Calibri v 11« A" A = = E
B~ o~ —
Paste o HE VA, ZEEE=ZEE H- Past I = ==
N B I U~ v v A S EE=ZE=E=E E < aste B I U-M. & A+ ===
Undo Clipboard 5 Font [ Alignment 5 | Undo Clipboard I Font I Ali
A2 v fx 2015 A2 v f 2015
A B C D E [ G H A B c D E E G

[ RENEE. WLV RF Ny [PORY N
Qﬁ
]
o~ dqlvaw =
[SRIN]
"oo
P P
@ N
2l

+
O Copy Cells
2 (e) Fill Series
10 o ~
11 10 () Fill Eormatting Only
12 " O Fill Without Formatting
B 12 O Hash il
14 13
15 14
16 15
17 16
18 17
19 18
20 19
Sheet1 ® 20
Ready % Accessibility: Good to go Sheet1 ®

Ready T?/Ac:essibility‘ Good to go

89°F || @ =
v Sunny .‘. Q L D - = 89°F

[ ]
v Sunny i. D L



Formatting Cells




Font Size

1. Select the cell(s) you want to modify.

2. On the Home tab, click the drop-down arrow next to the Font Size command, then select the desired font size. In our
example, we will choose 24 to make the text larger.

alls e w | =
D‘}E’ Calibri v A =E=2 -
Eg -
Paste o B I U~ A-B==E3
Clipboard & Font | 10 P Alignment
11
Al w7 12 FITMESS PROGRESS CH
14
A B . C D

2

1 FITNESS > {OGRESS

F_'4|:®
2 Date Weight ' 1est Waist
3 5/3/13 140 31

48

4 |5/11/13 140 31




Changing the Font

1. Select the cell(s) you want to modify.

2. On the Home tab, click the drop-down arrow next to the Font command, then select the desired font. In our example,
we'll choose Century Gothic.

ol _

D EJ‘E) |Centur§,r Gothic l24 AN T ==

R ([T e e —L

pajte ~ O Candara =3

Clipboard O CASTELLAR ient

O Centaur

Al » CH

O Century

A O Century Gothic
0 Century nchoolbook L
(o 3
() Colonna BT I
2 |Date O Comic Sans WS

O Consolas
3 ngfj O Constantia

4 |5/11, O Cooper Black




Changing Font Color

1. Selectthe cell(s) you want to modify.

2. On the Home tab, click the drop-down arrow next to the Font Color command, then select the desired font color. In
our example, we'll choose Green.

s -

D EJ‘{) Century Gothic ~[24 ~ A A @ — = — &~ E
Paste @ |B T U - [ O-EEE==E%xF
Clipboard T Font B Automatic

Theme Colors
AL N F B EEEESEN
A B I
FITNESS PrebRRaIS
1 Standard Colors
_ N EEEN
2 Date Weight Che . More Colort™
regn




Merging Cells

* Select any given amount of cells
* Click format > format cells

* Click merge cells
& B B s

e g ——— 5 Comments
?

— Format Cells

Z) v General ~ B Conditional Formatting ¥ & insert v >~ A? p E}
Number  Alignment Font Border Fill Protection - = z
$ v % 9 [FiFormatas Table - = TEr ¥ Sort& Find& | Analyze
Text alignment Orientation < I Cell styles ~ &~ Fiter~ Selectv | Data
Undo Horizontat M ] Number 5 Styles Editing Analysis ~
General ~ | Indent ‘.
= T
D6 Vertical: 0 - e
|| Text *

AN Bottom v ¢ | J K L M N o P Q R S A
1 Justify distributed *
2 .
3 Text control

0 =i
4 [ Wrap text S
5 T_| Shrink t0
6 erge cells;
7 e
8 Text direction
9 Context v
10
11
12
13
14
15
16
18 . '
19
20 v
Sample Data | Merging ® 4 >

Ready % Accessibility: Good to go L& Display Settings HH M - ——+ 100%

. 92°F ]|
%= Mostly sunny [ ] D L o

- ﬁ m e 'g‘ [ '! & AL B ) 7/249:1;:2»39



Text Wrap

* C(Click format > format cells

* Click wrap text

il o e ————————— O Comments

= Format Cells ? X

‘o v General ~ [ Conditional Formatting ~ B Insert ~ >~ év p

~ Number  Alignment Font Border Fill Protection -

N $ % 9 i Format as Table ¥ — [l Y Sort& Find&  Analyze

Text afignment Orientation %3 908 ﬁ Cell Styles ~ 6> . Filterv Select v Data
Undo Horizonish AR S Number [ Styles Editing Analysis v
| General ~ | Indent: .
— T
bs Vertical: 0 = . . .
X Text — ¢
A | Bottom v T . | 3 J K L M N (e] P Q R S a
1 Justify distributed .
2 .
3 Ext control =
0 2l b
4 E] Wrap text segrees
5 [y o fit
6 - Merge cells
7 Right-to-left
8 Text direction:
9 Context N7
10
11
12
13
14
15
16
17 Cancel
18
19
20 v
Sample Data | Merging ® ] >
Ready % Accessibility: Good to go L& Display Settings H H -—8—+ 100%
975K 414 PM

% Mostly sunny

=
3 . B DDE 0



Resizing Columns & Rows

Columns

* Right Click on the A column
* C(Click on Column Width
@ AutoSave (@ off Book1 - Excel O Search (Alt+Q

File Home

K).. O

Insert  Page Layout Formulas Data Review View Help

N & Calibri w1 A =& | ® ¢
@~
Paste o = . - - = = = e 5= -
e B I U~ [F+- & A ] .
Undo Clipboard m Font ] Alignment ]
B1 ~ fx
N Calibri Lm v A A': L3 v:/cnﬁ =] . - ]

1 2014 BI=O0vA-H-RAS
2 2015, I
3 2016,
4 2017,
5 2018 & cut
6

B copy
7
8 ‘B Paste Options:
10 0
n Paste
12
13 Insert
L Delete
15
16
17
T [l Format cells
19 Column Width
20

Shee

Ready % Accessibil

89°F
¥ sunny

Hide

Unhide

-EDI.fo-

Rows
* Right Click on the 1 Row
* Click on Row Height

il Autosave (@ or Book1 - Excel £ Search (Alt+Q

File  Home Insert Pagelayout Formulas Data Review View H

elp

) . ¢ A aw = — ab 3 -
7 ] & Calibri ‘i AN A =E=[=|%. | Genenl
. I~ )
Paste - B I U-~ oA E== = B 5%
Y <4 - %
Undo Cli puual:l 1] Font 1F] »'1|\,_lnl‘u"\l N Number 17
A2 R
Caibi v 11 ~ A A S % 9 E
LB I=4ovAvH- ~ IE F G H | J K
1 e
2 [ omr
3 srch the ment
4
5 & Cut
6 @ copy
7 Ra
8 0 Paste Options:
9 vas)
10 0
11 Paste Special.
12
13 Insert
14
15 B
= Clear Contents
17 E] Format Cells
18
19 Row Height.
20 fide
Ready
#
¥ Sunny D | D = (r H




Adding/Deleting Columns & Rows

Columns

@ AutoSave (@ off Booki - Excel O Sea

File Home

Right Click on the A column

Click on insert

Insert  Page Layout Formulas Data Review View Help

D~ ;D & Calbri AN ===
Paslerg B I U~H-OG-A =ZE==== B~
Undo Clipboard 5 Font -1 Alignment I+
Bl v e
Glbi v 11 v A A $ % 9 E
A . G H

1 2014 B I =& A~ d
2 2015 |
3 2016 h the menc
4 2017
5 2018 A cu
E @ Copy
8 [T Paste Options:
10 O
1
12
13
14
15
16
k=
. [ Format Cells
19 Colurmn Width
20

Hide

Shee
Unhide

Ready Y% Accessibil

89°F
¥ cunny

HOoO®o

Rows
* Right Click on the 1 Row

* C(Click on Insert

@ AutoSave (@ oft Book1 - Excel £ Search (Alt+Q

File Home Insert Pagelayout Formulas Data Review View Help

v . < . _ - : .
? 0 4 Calibri 1A A === ab, General
[~ .o s
paste |0 B I U~ v & A = B~ $ %

S S . 3 &

Undo Clipboard 3 Font [ Alignment m Number &
Calibri  ~ 11 -

— B I =4 E B <] H | J K
[ e

2

3

4

5 & Cut
& @ copy
7

8

8

‘B Paste Options:

- Clear Content
17 E] Eormat Cells

19 Row Height

lide

ide

Ready

BT HoPuoF_.CB




Conditional Styles

* Click the home tab on the ribbon

* Click Conditional formatting

G AutoSave m [E"f} Beginner Excel Sample Data = Saved v O Search (Alt+Q) Corrigan, Maggie ff’ & — o X

7 Comments

sert Pagelayout Formulas Data Review View Help

9> > Calibri vy A == @%’/v ab, General o 2~ ey O E1
. @~ $ % 9 l-l
Paste B I U~ SbeA. =Z=E==x= BH- [=) Highlight Cells Rules > | L d& | Analyze
. & u =Y = = = £= 2= %8 408 . Highlig ells Rules Greater Than... Let ~ Data
Undo Clipboard & Font 5 Alignment 5 Number [ E.—q Analysis v
i > ﬁ::ﬂ
Top/Bottom Rules Less Than...
< L
c11 v fr v
A 8 —C D E F G H J @ Data Bars > @ Between... Q R -
1 Textbooks Quantity Cost
2 Math 312 $ 430.00
3 English 580 $ 279.00 ﬁ Color Scales > EE Equal To...
4 Physics 610 $ 754.00
5 Chemisty 436 $ 167.00 Icon Sets > B:TEF" Text that Contains...
6 U.S. Government 132 S 254.00
7 Biology 826 $ 524.00 A New Rule.. )
8 Sociology 265 $ 178.00 EI‘% A Date Occurring...
9 Psychology 175 $ 452,00 B Clear Rules >
0 $3,038.00 =] Manage Rules... @ Duplicate Values...
1
2 More Rules...
3
4
5
6
7
8
9
0 -
Sheet1 | Sheet3 ® ] 3
Ready ﬁ’(Accessihility‘Invesiigate [& Display Settings i3] B ——8—+ 100%
. 92°F Em @ - = © s 405 PM
%= Mostly sunny JE p L D = e - * G er m ﬂ . NE R DB 7/29/2022 e



Number Formats




Number Formatting

* Click on the home tab

* Click number format

& L =
D 5 Calibyri M A A T == - % General
Pate o (B I U- H- | O-A-E==== E- §$-% >
Clipboard Font I Alignment r Mumber
Al - J 21
A B C D E F G H
1 21
2 33
3 16
4 29
o 15
[ |

ot
oo
=r=1

ul



More Number Formats

e
DC% Calibri AN T ==
By ~
Pavste\. B I U- SH-A- === &=
Clipboard = Font ] Alignment
A2 e £ || 2/3/2014
A B
Shipping Date Expected Arrival Date

2 2/3/2014 2/10/2014
3
4
5
6
7
8
9

= %Condition
EF‘ | T oo
kas
- General
Mo specific format rles
[F} 5t
Number
41673.00
Curren
c oy

S41,673.00
Accounting
$41,673.00
Short Date

2/3/2014

Long Date

Monday, February 3, 2014
Time

12:00:00 AM

Percentage

4167300.00%

Fraction
41673

Scientific
4.17E+04

ABC Text
41673

More Mumber Formats...

w

w0

A B

Shipping Date Expected Arrival Date

Monday, February 3, 2014, Monday, February 10, 2014

Alignment

Category:

General
MNumber
Currency

Accountini

Time
Percentage
Fraction
Scientific
Text
Special
Custom

Format Cells

Font Baorder Fill Pratection

Sample
Maonday, February 3, 2014

Type:

*3/14,/2012 ~
*Wednesday, March 14, 2012

314 k‘

31412

03/14/12

14-Mar

14-Mar-12 bl

Locale (location):
English [United 5tates) v




Formula Introduction




Basic Formula Operations

=Al1+A2 Adds cells Al and A2

=C4-3 Subtracts 3 from cell C4

=E7 /)4 Divides cell E7 by 14

=N10*1.05 Multiplies cell N10 by 1.05

=R5"2 Finds the square of cell R5




Creating a Formula

1. Select the cell that will contain the formula

2.  Type the equals sign (=)

SUM - x v £ | =
4

2

3 PRICE PER UNIT LINE TOTAL
4| 15 $8.75

5 18 $2.59

6 9 $14.25

7 12 $2.99

a

»

2]
10 JUNE BUDGET $1,200
1 JULY BUDGET $1,500
12 TOTAL




Format Painter

9~ & Cut Calibri 1A A == e
¢ @ Copy ~
i i B I U-~ G- AL === ==
* Click Home on the ribbon < Format Painter
Undao Clipboard [ Font [ Alignment
* Click on a section of the working document with a format that can be replicated. 8 . 5[ 17
H H A E © D E F G H J
* Click Format Painter Prem—
1 |Textbooks Quantity Cost
. 2 |Math 312 $ 430.00
L]
Select the cell(s) that you want the format applied too 3 |English 580§ 279,00
B AutoSave @) TL  Beginner Excel Sample Data » Saved £ search (alt+Q) 4 |Physics 610 S 754.00
5 |Chemisty 436 $ 167.00
File Home Insert  Page layout Formulas Data  Review View Help
— & |U.5. Governmeni 132 5 254.00
9~ [—"'j & Calibri |1 . 2, Wrap Text Accountin 7 |Biclogy $
b B I U- . & A B Merge i Center ~ § ~ % g |5°°i°|0€\" S
9 |Psychology
Undo ' B Font 1] Alignment 1F] Nu 10
cs ~ fe 178 oa
A B C D E F G H I J K L 17
i W) [ Beginner Excel Sample Data - Saved v O Search (Alt+Q) 1 Texthooks Quantity Cost -
2 |Math 312 $ 430.00
ile sert  Pagelayout Formulas Data Review View Help 3 English 580 $ 279.00 14
4 Physics 610 $ 754.00
9 b Cut Calibri i AN E == # b, Wrap Text Accounting 5 |Chemisty 436 $ 167.00
[ (@ Copy ~ |- = — _ & U.S.Government 132 § 254.00
B I U~y & A === =% EMegetiCeonter - § - % 7 Biolo 826 $ 524.00
<¥ Format Painter oy
Undo Clipboard N Font [F] Alignment ] MNum 2 25Cli|ﬂlg‘( i?:Eg:is-zzz—g-—g-!
sychology X
3 ~ fr 78 10 $3,038.00
A B C D E F G H I J K L j
Textbooks Quantity Cost | ;
Math 312 $ 430.00
English 580 S 279.00
Physics 610 $ 754.00
Chemisty 436 $ 167.00
U.S. Governmeni
Biology
Saciology
Psychology

$3,038.00



Complex Formulas




Creating a Complex Formula

* In the example below, we are wanting to calculate sales tax

METWOREK... ™ X W Je =(D3+D4+D5)*0.075
A B C DO E
2 [] [ ]
2 |Tamales: Carnitas $2.29 201 545.801
4 Tamales: Vegetable $2.29 301 568.?01
s |[Empanadas: Nutella & Banana S$3.99 40 §159.60

6 TAX| =(D3+D4+D5)*0.075

7

8



Relative and Absolute Cell
References




Copying a Formula Across Cells

1. Enter the formula to calculate the desired value. In our example, we'll type =B4*C4

2. Locate the fill handle in the bottom-right corner of the desired cell. In our example, we'll locate the fill handle for cell D4.

c4 > x v kK =B4*C4

3

2 |Empanadas: Beef Picadillo

s |[Empanadas: Chipotle Shrimp
& | Tamales: Chicken Tinga
7 |Tamales: Vegetable

g |Arepas: Carnitas $2.89
g |Arepas: Queso Blanco 52.49
10 |Empanadas: Apple Cinnamon $3.19
11 |Beverages: Horchata 51.89
12 |Beverages: Lemonade $1.89
13 |Beverages: Tamarindo $1.89

14

15

10
20
40
25
35
10

C D E
3
4 |Empanadas: Beef Picadillo $2.99 544,
s |[Empanadas: Chipotle Shrimp $3.99 10
¢ ' Tamales: Chicken Tinga $2.29 20
7 [Tamales: Vegetable $2.29 30
g |Arepas: Carnitas $2.89 10
g |Arepas: Queso Blanco $2.49 20
10 |[Empanadas: Apple Cinnamon $3.19 40
11 |Beverages: Horchata $1.89 25
12 |Beverages: Lemonade $1.89 35 |
13 |Beverages: Tamarindo 51.89 10 _|f

14

15

3. Drag the fill handle down



Creating an Absolute Cell Reference

1. Select the cell that will contain the formula
2. Enter the formula to calculate the desired value. In our example, we'll type =(B4*C4)*SES2, making SES2 an absolute
reference.
NETWORK... ~ X K | =(BA*Ca)*SES2
A B C D E

> TAX RATE: 7.5%]
3
4 |Empanadas: Beef Picadillo 52.99 =(B4¥C4)*SES2 S44.85
s |[Empanadas: Chipotle Shrimp $3.99 10 $39.90
& |Tamales: Chicken Tinga $2.29 20 S45.80
7 |Tamales: Vegetable §2.29 30 S68.70
s |Arepas: Carnitas $2.89 10 $28.90
g |Arepas: Queso Blanco 52.49 20 S49.80
10 | Empanadas: Apple Cinnamon $3.19 40 $127.60
11 |Beverages: Horchata $1.89 25 S47.25
12 |Beverages: Lemonade 51.89 35 $66.15

13 |Beverages: Tamarindo $1.89 10 $18.90
14

15



Functions




Most used Functions within Excel

SUM: This function adds all of the values of the cells in the argument.

AVERAGE: This function determines the average of the values included in the argument. It calculates
the sum of the cells and then divides that value by the number of cells in the argument.

COUNT: This function counts the number of cells with numerical data in the argument. This function is
useful for quickly counting items in a cell range.

MAX: This function determines the highest cell value included in the argument.

MIN: This function determines the lowest cell value included in the argument.




AutoSum

Quickly calculate with AutoSum

1. Select the cell below the numbers you want to add.
2. Select Home > AutoSum

2 AutoSum ~
1. Press Enter. S T S

Invoices Invoices

: $56.89 $56.89
I $34.78 $34.78
i $23.67 $23.67
! $123.56 $123.56
| $256.34 $256.34
| $32.45 $32.45
|_$567.891 $567.89
|=suM(52:5 $1,095.58




Finding the Average

* Type =, then the word AVERAGE

* Enter the cell range for the argument inside parentheses

C10 v X « | =AVERAGE(C3:C9)
A B C

1 Frontier Kids Cookie Sales

2 Troop Name Troop 1D Units Sold

s |North Bend #3506 [1004 I
4 | Silver Lake #2745 938

5 | Mountain Top #1038 745

6 |Rocky Trail #3759 729

7 | Forest Path #4157 862

8 | Green Valley #1932 890

g |River View #4233 ffa
10 Average Units =AVERAGE(C3:C9)
1




Finding the Count

1. Click on the formulas tab > More Functions
2. Click Statistical > CountA

3. Select the desired cell range

Q Tell mew

Page Layout Formulas Data Review View

[= B B o St

fi Use in Formula
Financial Logical Text Date& Lookup& Math8&  Mare Mame

o
#20 Trace Prece

“:E Trace Depe

= = ~  Time~ Reference~ Trig~ Functions= Manager £ Create from Selection & Remave Ar
Function Library P, Statistical 4 CONFIDENCE.NORM -
MR Engineering » CONFIDENCE.T
B Cube > CORREL
B : L@ Information  » COUNT Ii
{ B Compatibility » COUNTA b i
of 12) 3 STl web 8 '
COUNTA(value1,value2,)
= of 10) S 52014 S]_O Counts the number of cellsin a
r {50 |b) 5 51405 S? range that are not empty.
(25 1b)) 5 $18.69 $9 | @ Tellmemore
COVARIANCES
b.) 5 $10.99 S5 . ?
lon) 5 $11.99 S5 EXPONDIST z
1se of 10) 3 51949 55 E.DIST 1
lon) 8 $7.35 S5 F.DISTRT p
1 gallon) 12 $8.47 $10 R :
lon) 4 $28.69 $11 PR :
TotAL  $76 |
FISHER

number

Value2

= 10
Cowunts the number of cells in a range that are not empty.

you want to count. Values can be any type of information.

Formula result = 10

Help on this fundion

Function Arguments
COUNTA
— Valuet {"Tomatoes [case of 12)";"Black Bean...

Valuel: wvaluel,value2,... are 1to 255 arguments representing the values and cells

Cancel




Max

1.
2.
3.

Click formulas > AutoSum
Click Max

Enter in desired range of numbers

R

@ o

ﬂ AutoSave @ ['(_rn,_-g Beginner Excel Sample Data = Saved ~ pe
File Home  Insert Formulas Data Review View Help
ﬁ. |Z AutoSum > Logical ~ ~ ° E_.._-, Trace Precedents Vf\
I.nsert > Sum e Defined q‘aTraceDependents A~
Function Lverage te & Time~ [~ | Names¥ | B pemove Arows ~ (B
c £ Numb Formula Auditing
Loun umpers
G523

Tomatoes [case of 12)

7 |Black Beans [case of 10)
2 |All Purpose Flour (S50 Ib.)
3 |Corn Meal/Maza (25 |b.)
1 |Brown Rice (25 |b.]

Lime Juice (1 gallon)

1z |Tomato Juice (case of 10)
1z |Hot Sauce (1 gallon)
14 | Salsa, Medium (1 gallon)
15 | Olive Qil (2.5 gallon)

More Functions...

[ [u]

Food Service Supplies

Sabrosa Empanadas & More
1202 Biscayne Bay Drive
Orlando, FL 32804

3 $17.44 $52.32
= £20.14 $100.70
5 $14.05 $70.25
5 518.69 $93.45
= $10.95 55495
5 $11.99 $55.55
3 $15.49 558.47
g 37.35 558.80
12 $8.47 $101.64
4 528.69 5114.76

0 |Total items ordered
1 | Wost expensive item

53

Average days in transit

12-0ct
12-Oct
12-0ct
12-0ct
12-Oct
16-0ct
16-0ct
16-0Oct
15-0ct
15-0ct

15-0ct
17-Oct
14-0Oct
15-0ct
15-Oct
20-0ct
19-0ct
20-Oct
23-0Oct
24-0ct



Min

1. Click formulas > AutoSum
2. Click Min
3. Enter in desired range of numbers

ﬂ AutoSave @ ['(_rn,_-g Beginner Excel Sample Data = Saved ~ pe
File Home  Insert  Page Layout Formulas Data  Review View Help
ﬁ. |Z AutoSum  ~ Logical ~ e E_.._-, Trace Precedents Vf\
I.nsert > Sum xt~ e Defined L_“E| Trace Dependents [ ~
Function Lverage te & Time~ [~ | Names¥ | B pemove Arows ~ (B
c £ Numb Formula Auditing
Loun umpers
G523

R

@ o

r
53

Max

% =] [ [n]
- Food Service Supplies

More Functions...

Sabrosa Empanadas & More
1202 Biscayne Bay Drive
Orlando, FL 32804

Tomatoes (case of 12) 3 517.44 $52.32
Black Beans (case of 10) 5 320.14  $100.70
All Purpose Flour (50 |b.) 5 $14.05 $70.25
Corn Meal/Maza (25 |b.) 5 318.69 $93.45
Brown Rice (25 |b.) 5 310.39 354.595
Lime Juice (1 gallon) 5 $11.99 $59.95
Tomato Juice [case of 10) 3 §15.49 $58.47
Hot Sauce (1 gallon) 8 $7.35 $58.80
Salsa, Medium |1 gallon) 12 5847 310164
Olive Ol (2.5 gallon) 4 $28.69 $114.76

Total items ordered
Most expensive item

Average days in transit

12-0ct
12-Oct
12-0ct
12-0ct
12-Oct
16-0ct
16-0ct
16-0Oct
15-0ct
15-0ct

15-0ct
17-Oct
14-0Oct
15-0ct
15-Oct
20-0ct
19-0ct
20-Oct
23-0Oct
24-0ct



Basic Worksheet Functions




Sort & Filter

* Click home on the ribbon
* Click on the cell(s) that you want sorted

* C(Click Sort & Filter

9 A Gt ol B Y

; %‘:/' %EJWrapTa(t Accourting . ﬁ @ @ @ g}j( @ ¥ Autobu

[BCDW ’ Bl U~ Tvb.o A, === % Merge&[enter . $ LU (—ug m  Conditional Fomatas Cell  Insert Delete Format e
< Format Pinter - i I Fomating* Teblev Syl v v v Oy
Undo Cliphoard Iy Font Iy Alignment fy Number Iy Styles Cells Editi é\l Sort it o angest q
(6 v fr 1] sotLargsttoSrllest |
A B { ) E f G H J K L M N 0 p Q R § T Custom Sort. A
1 Texthooks  Quantity Cost 7 b
Iter
2 Math 12 5 43000 :
3 |English 580 5 27900
4 |Physics 610 § 75400
5 |Chemisty 45 5 16700
6|U.S.Governmem 137§ AN |
7 |Biology 826 5 5400
& [Sociology %5 5 17300

o |Psychology 175 § 45200
10 §3,098.00

=1




Insert/Delete Worksheets

At the bottom left hand on the screen click the # button
to add a worksheet

@ AutoSave (' Off)' Book1 - Excel £ search (Alt+Q)

File Home |Insert Pagelayout Formulas Data Review f/ View Help

5 - X * To delete a worksheet, right click on the sheet name
- PR — General
Calibri 11 AT A ==&~ b :
E] o - Eks Ty *  Click delete
Paste B I = = 3= . ©°
v - = = | &= 0 00 B "
0 =0 & AutoSave (@ off H Book1 - Excel earch (A
Undo Clipboard @ Alignment ™ Number T
AL f File Home Insert Pagelayout Formulas Data Review View Help
N4 X -
A B c H J t] & | Caibri dn P A oA | = = a
2 —_— ‘ ey sru-E-0-A- sEEEE B
§ Undo Clipboard 1] Font 5 Alignment
4 A1 v fx
5 A B C D E F G H |
6 | -
7 2
3
8 4
9 5
10 e Insert
11 7
12 8 EB Delete
9 17 Rename
13 i E7 Rena
14 1 Move or Copy
15 12 -
16 13 B vew Code
17 14 En Protect Sheet
18 2 labColor >
19 16
17 Hide
20 18
Sheet1 | Sheet2 19
Ready 5 Accessiilly: st 20 Select Al Sheets
eady & Accessibility: Investigate ; Sheetl | Sheet3 ®
L

& gg“:ny -‘= D - D rf e l | Ready ::/:sh Goodtogo ,
¥ sunny i= p [ D f



Renaming a Worksheet

 Double click the sheet name



Coloring Worksheet Tabs

& AutoSave [El

Beginner Excel Sample Data » Saved

o CIICk home nsert  Page Layout Formulas Data  Review  View
9~ & Cut Calibri YA A=
H H [Bce v
* Right click on any worksheet tab paste B COPY B I U-HE. G-A. =
¥ < Format Painter
Undo Clipboard 7] Font ]
e Click on tab color - . AR
A B = D E F G
Textbooks Quantity Cost
2 |Math 312 § 430.00
3 |English 580 & 279.00
4 |Physics 610 $ 754.00
5 |Chemisty 436 § 167.00
6 |U.5. Government 132 § 254.00
7 |Biology 826 § 524.00
2 |Sociology 265 $ 178.00
9 |Psychology 175 & 452.00
10 $3,038.00
12
13
14
15 Insert...
6
7 BE Delete
8 @ Bename
9 Theme Colors
Move or Copy...
20 H ENE HE
21 E View Code
= B:g Protect Sheet...
23 ]
24 IED TR IIIIIII
25 Hide
26
27
28 , .
Mgt All Sheets Mo Color
Sample Data Merging
C‘D More Colors..,
Ready T:f'/Accasslb qo

Help

M Search (Alt+Q)

= B EE; Wrap Text
= = = Merge & Center ~
Alignment
H J K

[P



Freeze Panes

Freeze the top row of column headings so
that only the data scrolls.

e Click view

u AutoSave @ E% Beginner Excel Sample Data « Saved v £ Search (Alt+Q) Corrigan, Maggie T’ & = o9 X
* Click freeze panes | |
File Home Insert Pagelayout Formulas Data Reviel Help 7 Comments
+ ] ’ =
Default ~ @ @ 8] Page [ayout Formula Bar Q D 3 New Window [ Split (k) F‘
* Select freeze top row B B @ o = = = R T
o . — ormal| Page Break = . o ) oom ‘oom to witcl acros
B < €p New = Preview [[E| Custom Views Gridlines Headings Selecli - i Windows v .
*M ust Select the Cel | BELOW the Column Sheet View Workbook Views Show Zoom #PEZ%¢ Panes Macros v
. E1 v f:‘ Hﬁ Unlock all rows and columns to scroll «
hi h th ire worksheet.
that you would like to freeze . o P troughtheetreworchee .
5 % Freeze Top Row
1 [Textbooks Quantity Cost Hﬂ Keep the top row visible while scrolling
2 |Math 312 S 430.00 through the rest of the worksheet.
J Engli-sh 580 § 279.00 & Freeze First Column
4 F’hyslc_s 610 5 754.00 Hﬂ Keep the first column visible while scrolling
5 |Chemisty 436 $ 167.00 through the rest of the worksheet.
6 |U.S. Government 132 § 254.00
7 |Biology 826 $ 524.00
8 |Sociology 265 § 178.00
9 |Psychology 175 S 452.00
10 $3,038.00
11
12
13
14
15
16
17
18
19
20 o
Sample Data = Merging ® 4 »
Ready % Accessibility: Good to go L& Display Settings H M —-——+ 100%

< !?/Iz(::t\ysunny == D L D @ _- ¢ a ?ﬁ q _§.o @ I! F 7 (5 e Ep = 7/;;20"2’2



Scaling options (fit all rows/columns to page)

* Click file > print
e Click fit all columns to one page

m Beginner Excel Sample Data - Saving...

G)
ﬁ Home
D New

= Open

Info

Save a Copy

Share
Export
Publish

Close

Account
Feedback

Options

92°F
*  Mostly sunny

Print

[:JS’] Copies: 1 z

Print

Printer Properties &
Settings
@ Print Active Sheets
Only print the active sheets

Pages: T to °

No Scaling
Print sheets at their actual size

. FitSheet on One Page
D Shrink the printout so that it
fits on o

Fit All Columns on One Page

hrink the printout so that itd
one page v

Fit All Rows on One Page

Shrink the printout so that it is
one page high

Custom Scaling Options...

Fit All Columns on One P...

-

Shrink the printout so tha...

Page Setup ¥ 1 oft

HowoR.CcB W

Corrigan, Maggie ;-’ P\'j

Textbooks Quantity Cost
Math 3125 400
Erglish 580 S 279.00
Physics €10 § 754.00
Chemisty @55 1.0
U.S. Government 132 5 254.00
Biology 826 5 524.00
Sociology 265 5 178.00
Payenciogy s & a0

30300

H A d

®



Page Setup (to show gridlines / column

headings)

* Click file > print
e Click Page Setup > sheet

* Check gridelines & row and column headings

®
(1] Home
[ New

B Open

Info
Savea Copy
Share
Export
Publish

Close

Account
Feedback

Options

Print
fé:] Copies: 1 :
Print
Printer ©
== ATLC Xerox .
Ready
Printer Properties
Settings
ﬁ Print Active Sheets
Only print the active sheets
Pages: Clto B
Print on Both Sides
/" Flip pages on long edge
mn Collated .
123 123 123
TS Mo Staples -

Portrait Orientation -

D Letter -
83" x 11"
@ Narmal Margins

Top: 0.7

5" Bottom: 0.7

Mo Sealing
00 Print sheets at their,

Page Setup

Page Margins  Header/Foote
Print area:
Print titles

Rows to repeat at top:

Columns ta repeat at left:

‘Comments and notes:

Cell grrors as:

O Down, then over
() Over, then down

(None)

displayed

oK

>

»

<

Options..

Cancel

anything to print.



Resources

https://support.microsoft.com/en-
us/office/analyze-and-format-in-excel-

This handout was created using 11a632c1-197e-454f-a515-374a4aa2b3dd
information from the following sites:

Free Excel 2016 Tutorial at GCFGlobal



https://support.microsoft.com/en-us/office/analyze-and-format-in-excel-11a632c1-197e-454f-a515-374a4aa2b3dd
https://edu.gcfglobal.org/en/excel2016/

Assistance
at TTU

For technical assistance,
please contact IT Help
Central at (806) 742-
HELP or
ithelpcentral@ttu.edu.

More information and training
resources, including training
videos, can be found at:

http://unifiedcommunications.
ttu.edu. You can also contact IT
Education Services at
iteducation@ttu.edu or call the
ATLC at (806)742-1650.



http://unifiedcommunications.ttu.edu/

